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1 Introduction 

1.1 Scope 
ScoreEngine is a Windows program which runs the DOS programs Score3 and Score4 
and their utilities in emulation. It benefits from typical Windows features without 
restricting the original DOS functionality. The look and feel of ScoreEngine is identical 
to the DOS version and the added Windows functionalities are intuitive. The user 
influences the level of additional Windows features which are self-explanatory to an 
experienced Score and Windows user. 

1.2 Rationale 
Newer versions of Windows are increasingly hostile to DOS programs and future 
hardware will not have native 16-bit instruction support which is a requirement for Score. 
ScoreEngine is not using any DOS functions and is therefore entirely independent from 
the presence of DOS on a modern system. 
While a pure Windows version of Score has been available since early 2009, it is felt that 
the program is not as popular as its DOS predecessors. ScoreEngine therefore is a valid 
alternative for users accustomed to the original program. No additional font software is 
required. 
ScoreEngine offers an investment protection for Score users for as long as Windows will 
be alive while there is no need for additional training or documentation. 
On top of that there is a tendency to work with ever larger or multiple screens – a 
tendency fully in line with the philosophy of ScoreEngine. 
Today a standard document format, PDF production is integrated in both Score and 
Scorlas when running under ScoreEngine. 
It is also felt that some function which were missing or cumbersome for which additional 
features have been added. An example is the placement and manipulation of lyrics. 

1.3 License issue 
ScoreEngine requires that the user has a license for the original DOS program and that 
Score is resident on the system. The Score license is verified by ScoreEngine. As such, 
ScoreEngine does not make any infringement on the Score copyright as it will not be able 
to run without the original licensed program. 
ScoreEngine itself comes with a license as well. At order time, the user must provide his 
Score license number(s). This is, or these are then coupled to the license number of an 
individual ScoreEngine license number. 

1.4 Score installation issue 
It is entirely possible to have both Score3 and Score4 on the Windows system.  
Note that Score need not be installed in the traditional way (INSTALL.EXE which will 
not run on Windows 7). The DOS files need to be present though. Moving from an old 
system to one with ScoreEngine, just copy the Score folders. 

1.5 Distribution policy 
A demonstration version is downloadable for free to anyone. It will work with the user’s 
original Score programs without any license check. 
The demo version however is not fully operational in that most output functions are 
blocked. When a ScoreEngine license is acquired, the individual license file is included 
in the installation medium. 
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It is felt that this approach is the most convincing way of promoting this product, as 
users can play with it and learn to appreciate the additional features which ScoreEngine 
offers over just Score while qualifying their version of Windows against this new 
product. 
When attempting to write a file in the demo version with any of the Score programs, an 
appropriate message is given. Some of those situations are critical and cause a terminal 
error. 

1.6 Product availability 
ScoreEngine is available for:  

SCORE  3.11-585 
SCOR4 4.01-555 
PAGE   3.1-540 and 3.11-540 
PAGE4  4.00-540 
SCORLAS  3.11 
SCORLAS4  1.0 and 1.01 
DRAW  3.10 
DRAW4  4.00 
JUST  3.01 
JUST4  4.00 

When users have different versions (which are called dialects in this context) of one of 
these Score programs they need to take contact with ScoreEngine development to 
investigate conformity. For SCORE and SCOR4, there is no dialect issue. 

2 Design considerations 
In general, the environment of ScoreEngine benefits from the many Windows features 
which make working with Score and its utilities more convenient. 

2.1 Screen issues 
Score dates from the time that a PC screen was rather limited in size while part of the 
screen needed to be split between a command area and a music display. The Score user 
had some control over the relation of command/music display with commands like Alt+C 
etc. Modern systems have much larger screens and users in many cases have more than 
one monitor on their computer. ScoreEngine separates the command function and the 
music display function in separate panels. While it works on a single monitor, 
ScoreEngine can work on two monitors. The user defines how the command panel and 
the music display panel are configured. The monitor configuration is selected by the user 
and remembered for subsequent sessions. 
One advantage of splitting the command and music display panels is that the latter can be 
at the maximum size as if the Alt+F were given. The bottom-of-screen commands are 
always given in ScoreEngine. 
The quality of the graphics displayed in the music panel is not better than that of DOS, 
even though Windows screens have higher resolution. This is because the actual graphic 
screen of DOS is emulated. One pixel for a DOS screen translates to one or a few on the 
Windows screen to give optimal visibility. 
The size of the command panel comes in two variants, normal and large. The large 
version is supplied to approach DOS size visibility. 
The music panel is dynamic in size. The default of 100% can be adapted to any value 
from 32% to 99%. This flexibility is provided because different screens give better 
resolution when set to a lower value than the maximum. Also, it allows a customized 
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screen configuration. The setting is remembered between sessions. When both 
command panel and music display panel are on the same monitor, a smaller music 
display will be necessary. On my laptop with a 15.4" WXGA (1280x800) Wide Screen 
LCD, both panels fit nicely on a single screen when the music display percentage is set to 
65. On my 24 inch screen both windows are also next to each other, the music display 
giving best results at 80 percent. 
The two-panel approach means that either one of the panels has the focus. After graphics 
operations on the music display, it may be necessary to click the command panel to 
obtain focus for typed commands.  
Some commands have been foreseen as a button function for user comfort. The command 
panel also recognizes mouse functions for the bottom control line with function keys and 
for some specific features. 
There are two types of fields and lists. The white background signifies a change or 
selection capability. A yellow background is a field that cannot be changed. Lists with a 
yellow background can be closed by clicking on any text. Other background colors are 
just commentary. 

2.2 Space issues 
Personal computers have lots more central memory and disk space than in the days when 
Score was first operational on a PC. Many tricks such as overlay technique had to be 
applied to assure that the limited memory could handle a single page of music on top of 
all the computer instructions. As ScoreEngine executes the DOS Score instruction per 
instruction, is also emulates the overlay technique but it has an improved mechanism that 
avoids disk access for the most common overlays.  
Disk space today cannot be compared to the limited space of the original diskette systems 
of the early Score days. ScoreEngine uses much more disk space than Score but it does 
considerably less input/output.  
Systems today are expected to have 2GB central memory or more. 
An attempt to run ScoreEngine on a Windows98 system with 32MB RAM (second 
edition 4.10.2222A) failed with a ‘not enough memory’ message. 

2.3 Speed issues 
Today personal computers are a lot faster than the systems on which Score originally ran.  
The processor speed allows the original instruction set to be emulated whereby one 8086 
or 8087 instruction (which Score uses) is performed by a number of instructions in the 
32-bit instruction set. The ScoreEngine emulator is written in 32-bit assembler and the 
program speed on fast processors is comparable to normal DOS Score operation. Some 
functions are even faster. With processors becoming ever faster, any speed inconvenience 
will disappear over time. 
Another factor slowing down the emulation is the screen paint time. In DOS, Score writes 
pixels to memory locations which are reserved to represent the screen pixels. 
ScoreEngine paints pixel by pixel. You have all interest in using a screen with a fast paint 
time. 
Disc access speed is not a factor of importance for ScoreEngine. Overlays, particularly in 
Score4, slowed down processing considerably. ScoreEngine keeps the overlays in 
memory and is therefore speeds up processing. 
Because of high speed in modern machines, features could be added that could not have 
been realized in the original programs – an example is the extended functionality of 
DRAW (with the ‘extended’ option set) which when asked now to read a vector list (F4-
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Read), immediately comes up with a table of all the files in the current directory which 
are vector lists. 
Another example is in PAGE (with the ‘filename drop’ option set) where option 2 (part 
extraction) scans the music files to generate the PARTS file while providing a list of the 
instruments encountered. 
Keyboard handling has improved drastically compared to Score which used to loop until 
a key was hit and thereby claiming the entire processor. 

2.4 Output considerations 
On top of a number of EPS enhancements, PDF files can be created from a music file 
through the XPDF command or a button in Score and automatically by Scorlas. 
Another option is to call PCSEND from Score(4) or Scorlas(4), passing it EPS files as 
printing to a port is not supported by ScoreEngine. PCSEND is a 16-bit program which 
excludes running it in 64-bit Windows 7. 
A feature is also added to incorporate ‘SipEPS01’ for staff line suppression under 
fingering and text, and ‘seps4id’ to prepare EPS files for InDesign. 

2.5 User comfort 
While the keyboard commands can be typed as in Score, ScoreEngine uses the mouse 
more intensively to replace a number of typed commands. Several Score commands were 
reprogrammed in pure Windows to benefit from modern hardware and a number of 
specific commands were added to make the life of the engraver easier.  
Changing parameters can be entirely done through mouse operations. 
The Score restriction of 24 characters (Score3, for Score4 it is 22 characters) for a file 
path has been lifted. 
The command area will sometimes provide a colored background to make specific 
information more conspicuous and it shows additional controls for extended features. 
Help file display is instantly for items being edited by just moving the mouse over the   
‘?-button’. Separate help forms may stay open during edit. 
ScoreEngine accepts the middle button of the mouse. The function was no longer 
operational with modern mice but ScoreEngine reinstates it for current mice. 
Copy and paste between ScoreEngine and other Windows applications is now possible 
and is useful mainly for text manipulation. A comfortable way to enter lyrics is with the 
‘automatic syllable placement’ feature which takes lyrics from a text file and pastes it 
under a staff, note by note. 
OLE technique is applied such that file selections from the Explorer can be dropped to 
the Score applications, thus saving valuable time. There is no more need to create names 
files for Score(4), Page(4) or Scorlas(4), or for a part extractor control file for Page(4). 

2.5.1 MENU4.DAT 
This file is used by Score4 and contains the details for the bottom function buttons. DOS 
Score4 keeps this file open from program start to end such that the DOS version and the 
ScoreEngine version cannot be run simultaneously. ScoreEngine therefore uses a copy of 
this file and works from the copy as not to block running the DOS version at the same 
time. 
Note that ScoreEngine keeps this file in memory thus avoiding disk access to it every 
time the band of bottom buttons is changed. 
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2.6 Keyboard issues  
While basically everything which can be done in DOS can also be done in Windows, 
there are keyboard differences inherent to the operating system and hardware. 
To facilitate typing of accented and special Score characters, an ‘insert symbol’ feature is 
provided. 

2.6.1 Keyboards 
The default keyboard is US QWERTY but other keyboards are supported. The selected 
keyboard must be equal to the language selection in the taskbar, assuming that the 
‘language bar’ is set (See ‘regional and language options’ in the control page, then tab 
‘languages’, then ‘details’, then ‘language bar’ then ‘show language bar’). 
Non US-keyboards have character keys such as ‘á’ which cause a space. To type 
accented characters, use the ‘Insert’ menu. Pasted strings in advanced text input may 
have accented characters which are automatically translated to Score. 

2.6.2 Function keys  
For Score3: Function key F10 cannot be assigned. Where a DOS F10-key is used in a 
Score utility, it is replaced by F11 and to highlight this exception it appears on the 
command screen in red like this: F11-Path. 
For Score4 this exception does not apply. 

2.6.3 The tabulation key 
The key labeled ‘Pause Break’ is identical to the TAB key and it works with Shift for 
backward tabulation.  

2.6.4 NumLock 
DRAW(4) uses ‘NumLock’ which ScoreEngine does not support. Use ‘Enter’ 
continuously to get to the next vector endpoints. 

2.6.5 Special keys 
Screen setting control keys which in Score are made with the ‘Alt’ key have been revised. 
A separate chapter explains this. See ‘Screen features’. 

2.7 Mouse compatibility 
Clicking outside the music display area (in the area above or below the music bezel if 
there is one) causes the horizontal coordinate to be ignored. 
Furthermore, the middle mouse button can be used to select another item when in Edit 
Mode. Many controls use the right or middle button for additional functionality and are 
always explained by a tooltip. 

2.8 The demo version 
The features which are blocked in the demonstration version are all related to output, 
sound and Midi. When such Score commands are given, the user receives a message and 
can in most cases continue operation as if the function were successful. The SCORE 
functions that are thus suppressed are: 

- music file output (SA, SM, DEC, XCC) 
- PMX file output (PMX) 
- printed output (PR, XPDF) 
- DPY (other than 1 or -1) 
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- Sound and Midi 

Note that macros can be saved in the demo version. 
The demo version suppresses all output of PAGE(4), SCORLAS(4).  
The DRAW(4) functions suppressed are Save and Write. 
Output of JUST(4) is not suppressed. 

2.9 Stepped development 
Early production versions of ScoreEngine will not have all the features of the DOS 
version of Score. When updates of the program are made available, there will be no 
additional charge.  
Users may request addition of as yet unimplemented features. Depending on urgency and 
feasibility, features will be added. Initially not available are sound input/output, Midi and 
color selection.  
ScoreEngine has been qualified for Windows XP SP3, Vista and Windows 7.  

3 Program organization 
The emulation of Score and its utilities is started from the ScoreEngine Dispatcher. The 
Dispatcher also serves other purposes: 

- to establish the links between the original Score software and ScoreEngine. When 
a user has Score3 or Score4 or both, the various programs are linked by the 
Dispatcher and this usually needs to be done only once in a production 
environment. Linking can be done manually, or the user can ask the program to 
discover for itself where the programs to be linked are; 

- once linked, to check whether those object modules (their dialects) are confirmed; 
- to establish links to folders which ScoreEngine uses, such as for PSC and PFB 

files, LIB and HLP files as the third party products PCSEND, PDFCreator, 
SipEPS01 and seps4id; 

- to set the monitor and keyboard configuration; 
- to define fingering and string settings; 
- to prepare service files for ScoreEngine; 
- to set the compatibility profile. 

 
The Dispatcher runs until exited. When any of the Score programs are running, the 
Dispatcher panel is hidden.  
The menu of the Dispatcher has some self-explanatory features. The ‘Help’ menu allows 
the user to access the User Guide from the web, provided he is online. 
 
The primary panel of the ScoreEngine Dispatcher is shown here: 
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SCORE(4) and DRAW(4) use a second panel for graphics. 
The two panels are described with their features in logical order. Note that both panels 
have a ‘minimize’ button. Left click on it to minimize the individual panel. Right click on 
either button and both panels will minimize. 

3.1 The Link profile 
Setting the link profile is usually done once in a production environment. When installed 
on or moved to another computer, or if you upgrade from Score3 to Score4 this function 
will need to be repeated.  
Also, when you decide to work with a different font library, the path is to be redefined. 
The Dispatcher’s main panel has a button named ‘Link profile’ which brings you to the 
Score environment setup. The panel which controls this phase is as shown: 
 

 
 
The ‘Automatic’ button will scan your entire system to locate the Score software 
products in the white column and establish the paths which ScoreEngine needs to load 
and emulate these programs. Depending on the size of your system, this can take some 
time. 
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To manually make a link to an individual Score utility (which could be faster), click 
the name in the white column and follow the dialog familiar to Windows users.  
Score and Page handle long filenames in a namelist, when dropped, or when kept from a 
previous run. This feature requires a work folder with a short name. The default is 
C:\$EWORK. 
 

 
 
The library files and help files are assumed to be on the same drive as SCORE.EXE or 
SCOR4.EXE with the standard paths. 
For Score3, the paths are <drive>:\LIB and <drive>:\HLP. 
For Score4, the paths are <drive>:\SCOR4\LIB and <drive>:\SCOR4\HLP. 

3.1.1 PSC folder 
ScoreEngine is more flexible in font matters than Score as you can keep different folders 
with PSC files and define per project which set you use. It does not use the path defined 
in PREF.SCR. The default defined by Score3 and Score4 is overwritten by this path. So 
when you work with different versions of FONTINIT.PSC there is no more need to 
rename that file as is necessary in Score3. 
Initially, ScoreEngine assigns the default folder. When the user sets a different folder it 
checks whether that folder indeed contains PSC files. 

3.1.2 Dialects 
ScoreEngine emulates the DOS executables SCORE.EXE, PAGE.EXE, etc. To emulate 
these executables, ScoreEngine expects the 16-bit instructions to be at unique storage 
locations. The executables of one particular version should therefore be identical, which 
is not always the case. There can be several dialects of for instance SCORE.EXE because 
at distribution time there were version differences which cannot be detected from the 
filename alone. Each unique version therefore has a dialect number. 
The Dispatcher has a function to verify that the executables used are indeed the ones 
ScoreEngine can work with by checking the file date and time stamp with predefined 
settings. Contact development when your object does not pass this check. 
A separate panel shows the supported program dialects. 
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Point to the question mark field for an explanation. 

3.1.3 Link utilities 
To define the path to the external programs dynamically called by ScoreEngine, click the 
white field and follow the instructions. 
 

 
 

3.1.3.1 SipEPS01 path 
To call this licensed utility during EPS creation, ScoreEngine needs to know the path. 
The options for this tool can be set in the ‘utilities’ panel of the Exec profile. The path 
needs to be defined only once. 
For a description of SipEPS01, see the SIP documentation. 

3.1.3.2 seps4id path 
To communicate to ScoreEngine that you have a license for ‘seps4id’ and that 
ScoreEngine needs to call it when producing EPS files, you need to define the path to that 
program once. 
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This program modifies some elements in an EPS file such that it is better prepared for 
processing with InDesign. The program ‘seps4id’ is sold by Thomas Weber. 

3.1.3.3 PDFcreator path 
This freeware program is a requirement if you want to make PDF files with ScoreEngine. 
It must be defined in the indicated path. PDFcreator can be downloaded from the internet. 

3.1.3.4 PCSEND path 
When EPS files need to be sent to the printer, use this external utility. It is delivered with 
ScoreEngine and automatically linked to it when the user has no path of his own. The 
program is in the program folder when the Dispatcher is running. 

3.2 The Exec profile 
The ‘Exec profile’ button on the Dispatcher brings you to a panel with tabs of which one 
is reserved for the developer.  

3.2.1 Peripherals 
The first tab defines the monitor configuration and the keyboard selection. ScoreEngine 
knows how many monitors there are and will select the appropriate setting. When you 
have more than one monitor you can force the use of a single monitor here. 
 

 
 
Also the music display size may be adapted here but it is simpler to do that when 
ScoreEngine displays it as there the effect can be seen immediately. 
Once you have moved the command and music display forms to your most convenient 
screen locations, these locations are remembered for the next session. Also the size of the 
music display is carried forward to the next session. 

3.2.1.1 Large command screen 
The command screen comes in two sizes. The large screen is about the size of the DOS 
version of Score. 
The View menu allows change of size once Score or one of its utilities is called. 
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3.2.2 Compatibility 
ScoreEngine has many added features to make life easier on the Score user. Select your 
preferences on the second tab ‘Compatibility’. The features are categorized in four 
groups – Commands, EPS options, Screen features, and Other features.  
 

 
 

3.2.2.1 Commands 
Filename drop 
When activated, the user can select a MUS file from the Explorer and drag/drop it to the 
command area. It will then be interpreted as a G command. To perform a GM command 
with this feature keep the Control key pressed. 
This technique can also be used to read text files such as PMX. Drop a PMX file and 
ScoreEngine will perform a RES rather than a G command. 
In the same way, an EPS file can be dropped when it has item information (referred to as 
MUSinfo in this guide) as described in “EPS post-processing, XEPS command”. 
ScoreEngine makes the distinction between these three formats itself. 
A nifty feature of ScoreEngine is that you can drag/drop multiple filenames from the 
Explorer to the command area. An inbuilt feature is that it creates a temporary file from 
the selection named COMBINED.MUS which is then the subject of the G or GM 
command. This way, the number of resulting staves might exceed 32 but excess staves 
will be ignored in this process. The loading of such files is bottom to top, in descending 
order. If for example you created the files DEC001.MUS till DEC009.MUS, these files 
can be combined in one drag/drop and DEC001.MUS becomes the top file. 
 
Recent files 
ScoreEngine remembers the files that were written by Score’s SA and SM-command. 
Use this history to select files on which you have worked recently. Clicking a name in the 
white list will perform the G-command. 
Initially, there are no recent files and ScoreEngine then assumes all the files in the current 
directory which have a MUS or a PAG suffix and have the valid Score format. 
 
GM input above highest staff 
Most of the time you will use GM to put a file on top of what has been loaded. This 
feature lets ScoreEngine find the highest staff above which input is to be read and not 
prompt for a staff number. Note that this option is effective in all variants of 
ScoreEngine’s GM-command, whether typed, by filename drop, or by the button.  
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GM-/+ 
Usually the GM command is issued on a logically previous or next file. To GM a 
previous file just type GM- and the file which alphabetically precedes the current file in 
the same folder will be added. The file suffix must be the same but the part before the 
period is only inspected for an identical alphabetic part. GM+ loads the next alphabetical 
file. 
The commands GM- and GM+ can be done multiple times and keeps stacking music 
files. 
To load more than one file in one go, use the filename drop feature, selecting multiple 
files. 
 
MUS validation 
Before reading a music file, ScoreEngine can validate the file for having the proper Score 
format. This function will not consider the file if it has a different format and give a 
warning. The feature was added since many users have Finale or other files with the 
MUS extension. ScoreEngine quickly looks at the contents to establish the digestible 
format. 
The switch is also checked when reading SET files for Staff setup. Also, the utilities 
Scorlas(4), Page(4), and Just(4) honor this switch. 

3.2.2.2 Lyrics 
Define here the size and font for the lyrics. Only when these are defined can you use the 
‘automatic syllable placement’ feature. 

3.2.2.3 EPS options 
When activated, ScoreEngine offers many enhancements to the EPS file creation. 
Following the creation of an EPS file by Score or Scorlas, optional post-processing can 
take place. 
A modern software package such as InDesign does not like the EPS ‘statusdict’ 
command which is generated when a Score file is taller than a certain size.  
The font initialization file which Score inserts in EPS files is in some cases ‘too late’ and 
needs to be moved forward as has been shown when defining special characters which 
Score does not recognize such as in Icelandic. 
One option causes comments to be generated. When activated, the parameter structure of 
each item will be included in the EPS file as a matter of documentation. Such a file may 
be read by the XEPS command. As such, the original MUS file can be recreated from the 
EPS file might it be lost. An example is given towards the end of this document.  
The ‘Overwrite’ option when set is functional for both EPS and PDF file creation. 
The ‘Skip progress reporting’ speeds up EPS creation considerably as it suppresses the 
arrow to point to each item being processed and by not giving the item count on the 
command screen. 
For font embedding to work, you need to have the PFB files for the desired fonts for 
which there is the tab panel ‘Font embedding’. 
As most printers have the Base35 fonts, you may wish to exclude those from embedding. 
 
SipEPS01 
This utility suppresses staff line portions when there is fingering or text in the staff. The 
‘Utilities’ tab has some parameter setting for this external program which it will pass. 
The features are documented separately in the User Guide for this program. To benefit 
from this feature you must have the license for SipEPS01. 
 
seps4id 
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When set, this program is executed immediately after ScoreEngine has created an EPS 
file, so before all the other extended features. The third party program ‘seps4id’ by 
Thomas Weber fixes problems in EPS files for use by InDesign. The user requires the 
license and the Dispatcher must have linked it. 
The program ‘seps4id’ makes a backup file by appending ‘.bak’ to the original name. It 
remains the user’s responsibility to clean up backups. 

3.2.2.4 Screen features 
Seconds splash screen 
The Score splash screen can stay displayed for 0 to 9 seconds. Experienced users set this 
to 0 once they have seen it bypass. 
 
Automatic SH/Z after G command 
When the files you are working on are not too big you may want them to load in display 
mode by default. This option controls the action. 
 
Automatic Z after DP/SH/SHX 
The Z command to show the effect of a previous command can be combined in this 
feature.  
 
Automatic SHX/Z after DP warning 
When there is not enough memory for display mode, a warning is issued. ScoreEngine 
allows you to perform a reset of the display mode automatically. 
 
Red arrow 
To get a more conspicuous pointer to Score items being edited, the small up-arrow can be 
colored red. When displayed and you redraw or resize the music panel, the arrow will 
change to the original color until it advances. 
 
Full screen at startup (“Alt+F”) 
Since the music display in ScoreEngine is separated from the command screen the user 
may wish to benefit from the larger display area. Note that the default area has a bezel 
which disappears when working in full screen mode. Score in DOS suppresses the bottom 
line F-key explanation in full screen but ScoreEngine shows them at all times. 
Note that the INP command sets the small screen. 
The combination of Alt+F is a menu letter to open the File menu as this is a Windows 
function. Type XFUL to set full screen. 
Note that screen view commands with Alt (C, O, D, U, and M) or screen positioning in 
Edit mode (Ctrl+L/R/U/D) are all ignored in Score under ScoreEngine. Alt+S is identical 
to Score in DOS. When not in Edit mode you can use the middle mouse button to 
position music. 
 
Invert Up and Down (Arrow/Page) 
This feature can be selected to make those screen commands in line with Windows 
practice. They are not inverted in Edit Mode, as there up is up and down is down always. 

3.2.2.5 Other features 
Extended PMX 
When set, the command PMX behaves differently from DOS Score. When the filename 
is omitted it will be taken from the currently loaded file. 
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The PMX file which DOS Score generates is rather difficult to be read by humans or 
third party software. The ScoreEngine format provides optional commentary and it can 
edit the PMX file in a tabular format.  
Example: 

 
 

8.  1.0    .000 
3.  1.0  10.000 
1.  1.0  20.000     5.00    12.00      .00     1.00 00     2.00 
1.  1.0  34.000     8.00    11.00      .00     1.00 00      .00 
6.  1.0  20.000     7.00     8.00    34.00    12.00 00  

 
The user may select the output to be condensed (which does not truncate fractions and 
removes trailing zero parameters) and output will look like this: 
 

 8  1  
 3  1 10  
 1  1 20 5 12 0 1 2.0007  
 1  1 34 8 11 0 1 -0.0007  
 6  1 20 7 8 34 12 

 
Optionally, comments may be included in either format. This feature makes the PM 
command redundant. An example: 
 

* ScoreEngine created PMX file - Creation date/time : 01-27-2010 - 12:03:22 
* STA.PMX has 5 items 
* Item number 1  Parameters: 3 
 8  1  
* Item number 2  Parameters: 3 
 3  1 10  
* Item number 3  Parameters: 8 
 1  1 20 5 12 0 1 2.0007  
* Item number 4  Parameters: 8 
 1  1 34 8 11 0 1 -0.0007  
* Item number 5  Parameters: 7 
 6  1 20 7 8 34 12  
* Measurement = INCHES 
* Score license = 3101073 

 
Files produced in any of the above formats can be read by Score as it ignores records 
starting with an asterisk. 
 
Immediate exit with SM 
The EX command in DOS Score is ignored when in Edit Mode (ScoreEngine gives a 
warning when this is attempted). When the ‘Immediate exit’ option is set, an additional 
exit becomes enabled in the File menu, which works also when in Edit Mode.  
The ‘Immediate exit with SM’ terminates but first performs the SM command. 
Note that the exit commands do the normal Score exit.  
The ‘Cancel’ termination is always enabled and stops the program without writing any 
unsaved updates (you lose them). 
 
Advanced help 
When set, a button is enabled with a question mark as its caption. This button has various 
functions: 
 

Pointing to it when an item was selected. 
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The parameter structure from the Score help file is momentarily shown under 
the displayed Score parameters. Optionally, their values are shown with 4 
decimals. 

 
Clicking the left mouse button (an item is not selected). 

A list rolls out with the names of all help files from which one can be selected for 
further display and one can walk through the available pages in that group. 
‘HELP.HLP’ is given first, right under the ‘?-button’. This is intentional such that 
another click on the same spot brings you to the main help page. 
From the main help page you can also click to further pages by clicking on a code 
number or its text. 
ScoreEngine reads the actual help pages but since there are some differences in 
the DOS and the Windows character sets, some characters are translated. A 
monospace typeface needs to be used (Courier New). In this font there is no 
equivalent for Code9 Par5=119 (≥) and the character shown is ‘ò’. 
A great benefit of this advanced help feature over DOS Score is that its display 
stays open while music editing can continue. The user can close it any time. Also 
notice that the help form always opens on the spot where it was last used. 
An example of this help form is given towards the end of this guide. 
Note that there is a help file called “ScoreEngine commands”. Select this to get a 
summary of the specific commands. 
 

Clicking the left mouse button (an item is selected). 
 Page 2 of the help file is given in a separate form. 
 
Clicking the right mouse button. 

A page from the Score manual is displayed, and one can walk though the 
available pages (pending approval of Leland Smith). 
The user can close it by clicking in the picture or by the Close button. Notice that 
this help form always opens on the spot where it was last used. Within one 
session, the last page remains current. The form can be resized by dragging the 
outer form edges. 
An example of this help form is given in the chapter ‘Advanced help output 
samples’. 
 

The Score4 button ‘F1-Help’ and the ‘??’ command cause advanced help when this 
switch is set and immediately shows the main help panel. 
 
Display 4 fractions 
For those users who need to see more fractional digits than Score displays, there is an 
additional panel which shows this when an item is selected and the mouse points to the 
help button. 
 
Forbid text items without font 
This gives an additional level of security. Score allows Code16 items without a font 
prefix. When set, text items must have the font prefix when entered or updated. 
 
Advanced font update 
Optionally you can see the font name of a text item by clicking on the prefix. The font 
can be replaced by a different number. The feature is shown further down in this User 
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Guide. Note that the font name of a selected Code16 item is always given in the music 
display’s left bottom corner. 
 
Advanced text input 
When set, text items can be entered in a more mouse oriented way, thus giving a paste 
capability from other Windows applications. The feature is demonstrated below. 
 
Advanced text modify 
When set, text items can be modified using a Windows type dialog, thus giving a paste 
capability from other Windows applications. The feature is demonstrated below. 
 
Suppress ‘any key’ after INC command 
Score3 only. The confirmation to this command was foreseen because of the vertically 
small command area. ScoreEngine does not have such restriction and the redundant 
confirmation can be bypassed. 

3.2.2.6 Length of filename 
The path length restriction of 24 or 22 characters has been lifted in ScoreEngine. The way 
this is done is as primitive as effective. The actual filename must be in the Score 8.3 
format but the path prefix can be anything. When a file is selected with a long path, that 
file is copied to the program folder with the name CURRENT.MUS and this file is 
presented to Score. All changes happen on this file. While this file is in memory, the 
original long name is shown above the Score command area thus: 
 

 
 
The copy of your file to CURRENT.MUS is done automatically by the Windows file 
selection but to copy it back requires a command. The XCC (Copy Current) will do that 
and will do an RS command to clear the memory. If you decide to terminate the edit 
without rewriting the file back (you lose the updates), then there is the XAB command 
(Abort) and no changes are made to the file with the long path, including those saved to 
CURRENT.MUS. 
There can only be one file name CURRENT.MUS at a time. While working on 
CURRENT.MUS, the commands RS, G and exits are blocked until either XCC or XAB 
is given. 
Intelligent NB/NX do not work (yet) when a file with a long file path is being processed. 
Long filenames cannot (yet) be kept between sessions and some commands refuse them 
with an appropriate message. 
Also note that when making EPS and PDF files from long filenames, the result goes to 
the default folder under the name of CURRENT.EPS and CURRENT.PDF. 

3.2.3 Font embedding 
Embedding fonts has several advantages: 

- you do not need to download files to the printer; 
- it gives flexibility to send EPS files to someone who does not have the fonts; 
- you can reliably create PDF files from EPS files with embedded fonts such that 

they are portable to any system. 
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Before ScoreEngine can embed fonts it needs to know where the PFB files are which 
contain this information for the fonts you have selected. As different projects may use 
different sets of PFBs, the path to the desired folder must be defined here. Click on the 
white field to change the selection. 
Currently, ScoreEngine does not use AFM files but it may do so in a future release. When 
you have AFM files, define the path here also. 
Then make an inventory. The inventory is nothing more than a structured file which 
ScoreEngine uses to link font numbers to PSC and their PFB files. In most shops, you 
will only have to do this once or occasionally as the settings are remembered by 
ScoreEngine. 
 

 
 

3.2.4 Utilities 
A few options pertain to the Score utilities. MUS validation is copied from the Score 
features frame and given here for information. 

3.2.4.1 Page(4) 
Overwrite  when set, does not give the message to overwrite the resulting file(s). 
Filename drop. Like Score the filenames can be dropped from the Explorer into the 
command area. A namelist file by the name NAMES.SEP will be created and the dialog 
automatically continues with this selection. Long filenames can be used. The input files 
will then be analyzed to see if there are more than one system per page such that the 
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PAGE question ‘Will any single file contain more than one system?’ is automatically 
answered by ScoreEngine. 
Also when extracting file this feature is very helpful as it allows the automatic creation of 
the part extractor control file. 
Erase PAGE workfiles. At the end of the program, the files BARS.TMP and 
DECnn.TMP will be erased. 
Erase own workfiles. At the end of the program, the files in the work folder (default 
name is C:\$EWORK) will be erased. Also the temporary file in the current directory 
$$$$NAME.LST will be erased. 

3.2.4.2 Scorlas(4) 
Note that under ScoreEngine, Scorlas will always send output to a file. Immediate output 
to the printer is blocked. Also, overwrite is the default option. 
PDF files can be made simultaneously with EPS files. 
When statistics are requested (the -1 option), they are written by default to file 
SESTATS.TXT and this file is automatically shown following the collection of this 
information. 
The demo version suppresses EPS output but it does handle the statistics option. 

3.2.4.3 Draw(4) 
This highly suggested ‘extended folder/file’ option will show a comfortable 

- folder selection panel when the Path command is given; 
- file and member selection summary when the Get command is given; 
- summary of vector lists when the Read command is given. 

Examples are shown in the chapter on DRAW. 

3.2.4.4 Just(4) 
The ‘filename drop’ feature makes life really easy so it is suggested to select it. An 
example is given in the chapter on JUST. 

3.2.5 Fingering 
Engraving fingering is a very time consuming activity and as this is one of the author’s 
regular jobs, automation imposed itself. The commands Xn (set finger n, n=0 to 5) and 
XSn (set string n, n=1 to 9) are foreseen to generate items on a selected note.  
For flexibility, the user can influence the horizontal offset calculation. Here are the 
features with my preferred setting: 
 

 
 

Digits for fingers are as a house style always on the left on an even Par4 as to cross staff 
lines or on the level of a ledger line. When a note is not on an even Par4, the finger is 
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moved one notch up for notes with a stem up (or unstemmed note), down for notes 
with a stem down. 
A button is provided to show actual Code10Par15 offsets and supplemental information. 
For circled strings, the command XSn (n=1 to 9) places the Code10 item above the stem 
for up stems, below the stem for down stems. Unstemmed notes cannot receive a string 
with this command. 
The options to be selected are: 

 

4 Score command panel 
Score users will appreciate the familiar Score command panel within a Windows frame, 
shown here for Score3: 
 

 
 
and for Score4: 
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The difference between those two screens is obvious – bottom functions in Score4 are 
represented by real buttons. 
The bottom line lists the familiar Score function buttons and other equivalences for letter 
commands. You can click them with the mouse (always after the ‘F’ in Score3). 
Typing characters is always in the keyboard input field. Most of them also appear then 
within the command screen. You can paste here with the ‘Ctrl+v’ feature which is 
particularly convenient while inputting music. Note that the right mouse click with the 
‘paste’ menu does not work. When you just used the mouse on another Windows 
application, you need to click the keyboard input field first to obtain ‘focus’ and you will 
see the cursor blink. When not in focus, you cannot enter characters in ScoreEngine. A 
mouse click in this panel automatically gives it focus.  
A double-click anywhere in the command area has the effect of typing the ESC key. 
Because of the separation between commands and music, more of the command panel 
will show useful information which in DOS is pushed off the screen: 
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4.1 The top menu line 
A line of intuitive menus familiar to Windows users is foreseen for the most common 
functions. 

4.1.1 File menu 
The File menu rolls out a submenu. 

4.1.1.1 Submenu Recent MUS files 
When this menu is selected, the selection panel is displayed as shown. The most recent 
file is on top. You can sort the selection on path name and back on time stamp. Only files 
which are currently online are given. Any file from the white list can be selected and the 
G-command is then performed. 
The maximum number of files ScoreEngine will remember is user defined in the Exec 
profile. 

 

4.1.1.2 Submenu Environment > 
This gives a submenu with the possibility to inspect some Score and ScoreEngine control 
files: PREF.SCR and CODE9.DAT. These files are shown with Notepad and can be 
edited.  
The folder where ScoreEngine expects PREF.SCR or PREF-4.SCR is the library folder. 
The path to CODE9.DAT is defined in PREF.SCR. 
Note that the PREF.SCR file which Score uses is dynamically adapted to a shortened 
version with keywords of maximum four letters. Screen is always set to 17 and the 
following keyword lines are removed: MOUS, DESC, KEYD, DOT, and LASE as well 
as any line with unrecognizable contents. 
Most control files typical for ScoreEngine are ordinary text files. Do not attempt 
changing these with an editor as this annuls the right to report errors. 
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The Link profile and the Exec profile can also be shown, as well as a font summary, 
the PSC/PFB/AFM inventory, and user defined String symbols. 
Close a display with a yellow background by clicking on text. 
 
Sub-submenu PRINT.SCR 
Note that the production of an EPS file by Score3 and Score4 under ScoreEngine does 
not use the values from PREF.SCR or PRINT.SCR. Instead these values are taken from 
the file ScoreEngineEPSsetup.TXT.  
The contents of ScoreEngineEPSsetup.TXT are displayed when pointing to the EPS 
button, together with the user’s EPS settings. To modify the contents of this file, select 
the EPS menu.  
In Scorlas3 and Scorlas4, PRINT.SCR is as in the DOS version where the ‘Read’ and 
‘Save’ options are functional. 

4.1.1.3 Submenu Current file summaries > 
This gives a submenu with four choices to obtain statistics on the current file: 

- totals per item; 
- a list of all text items, sorted per staff and position; 
- statistics of the Code16 items used, sorted by number. Includes font overrides; 
- staff sizes; 
- instruments. 

Close a display with a yellow background by clicking on a text. 
Example of ‘totals per item’:  

 
 
Example of ‘all text items’:  
 

 
 

Example of ‘Code16 statistics’: 
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Where ‘pfx’ means the number of times the Code16 item has the prefix, ‘inside’ means 
the number of times a font number is used inside a text item, and ‘override’ is the number 
of times Code16 Par8 is set to override any font in the string. 
 
The selection ‘Staff sizes’ shows how many staves there are in the current page for each 
size it encounters. Example: 
 

 
 

Example of the ‘Instruments’ summary: 
 

 

4.1.1.4 Submenu EPS log file > 
This gives a submenu with two choices: one named View EPS log file and one named 
Cleanup EPS log file. The first simply shows the list of all EPS files that were created 
with their date/time stamp. The second will remove all entries from this file that are no 
longer online (at the original path). 

4.1.1.5 Submenu Clipboard 
There are three clipboards in the context of ScoreEngine: (1) the Windows clipboard to 
pass information between ScoreEngine and other Windows applications, (2) The 
clipboard for Score3 emulation which can contain a text item, and (3) The Score4 
clipboard !!CUT.TMP. The submenu explains the features of these clipboards. 
The contents of each clipboard can be shown by a ScoreEngine function. 

4.1.1.6 Cancel 
Terminate ScoreEngine without checking whether the last updates were saved. This 
works in all modes for all programs. 

4.1.1.7 Exit immediate with SM 
Terminate ScoreEngine but first do an SM to assure that the last updates were saved. 
This works whether in Edit Mode or not. 
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4.1.1.8 EX/Exit(F8) 
Perform the Score exit command. When Score terminates in whatever fashion, control is 
returned to the Dispatcher.  

4.1.2 View menu 
The View menu rolls out a submenu: 

4.1.2.1 Less/More 
This controls display of the bottom part of the command screen which gives 
supplemental information on your current session. By default, this bottom is displayed. 

4.1.2.2 Normal/Large command form size 
A user option which is interesting for users who prefer DOS size characters is provided. 
The following is an example. Obviously, this feature is only possible when there are 
multiple monitors or with extra large screens. The large screen can be set as a start-up 
option or can be set dynamically at any time. This is a partial view: 
 

 
 
The Dispatcher allows a startup setting. The change can only be done when not in Edit 
Mode. 

4.1.2.3 Normal font (MS Sans serif)/Small font for Help list file 
Select this menu to assure that all names of help files are displayed by the ‘?-button’ in a 
list without the vertical scroll bar. The setting is kept between sessions. 

4.1.3 Insert menu 
Several items can be inserted. The roll out menu is self-explanatory. See the Insert 
commands for details. 

4.1.4 EPS menu 
The EPS menu starts a dialog. 
Here the user can maintain the setup for the PR command. Note that these user settings 
override any settings in PREF or PRINT preference files. When no user setup file exists, 
the PR will be done with default settings and the user preferences will be honored. This 
function replaces the READ and SAVE feature of the PR menu. 

4.1.5 License menu 
Self-explanatory. 

4.1.6 About menu 
Self-explanatory. 
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4.2 Command panel top line buttons 
Under the menu line there are buttons for the most common functions and recognizable 
from other Windows applications. Different utilities enable different buttons and some 
buttons may be disabled during specific operations. 

4.2.1 New page button 
This corresponds to RS in Score. When pushed with the right mouse button, the ‘yes/no’ 
prompt is bypasses. 

4.2.2 Open file button 
Equivalent to the ‘G-Command’. A Windows selection panel is shown. 
 

 
 
Filter by suffix. See the description of the File selection chapter for details. 

4.2.3 Open More button 
Text 

4.2.4 Intelligent NB/NX button 
Score3 is not very good at working with files which are not sequential. For instance when 
you have files BACH001.MUS, BACH002.MUS and BACH004.MUS where number 3 
is missing, Score will not find number 4 when 2 is loaded and you do an NX. Instead it 
will advance to BACH010.MUS. 
ScoreEngine has two buttons which proceed to the previous or next file which is the 
logical one, in the above case file 2 will advance to file 4 with the right arrow button. The 
left alpha part and the suffix must be identical. A right alpha part is allowed such as in 
BACH02A.PAG, BACH02B.PAG. 
Intelligent NB/NX do not work (yet) when a file with a long file path is being processed. 
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4.2.5 Save button 
This button’s function is identical to typing SM. Note that there is a feature to terminate 
ScoreEngine with a forced SM as to avoid the Score message “Any data not saved..”. 

4.2.6 EPS button 
This button is identical to the PR command. Do a right click if you want EPS file creation 
to be followed by PDF creation (The PDF button must be enabled). 
The EPS caption is underlined when ScoreEngine remembered the last created EPS file. 

4.2.7 Print button 
Score: When PCSEND is linked, this button when enabled will send the EPS file to the 
printer on LPT1. The EPS file must be the most recent produced in the current session. 
To see which EPS file is current, just point to the button. 
Before sending a batch to the printer, Score will prompt a user confirmation. 
Scorlas: When this button is enabled, Scorlas will send each EPS file to the printer. 

4.2.8 PDF button 
Score: The button is identical to the PR command. Click this button (it must be enabled) 
to create a PDF file. The EPS file must be the most recent produced in the current 
session. To see which EPS file is current, just point to the button. 
Scorlas: When PDFcreator is linked to ScoreEngine this button is enabled to signal that 
Scorlas will after having made the EPS files, create PDFs. 

4.2.9 Copy, Cut, Paste, Redo buttons 
Score3: Only when a text item is selected will the Copy and Cut buttons become enabled. 
Then when the copy exists (kept in file ScoreEngineClipboard.TXT) and a staff item is 
selected, the Paste button comes up. Point to the Paste button to see the saved item. Press 
Paste to insert it. A dialog asks for Par3 and Par4. The Undo is never enabled for Score3. 
Score4: These buttons are identical to the bottom buttons Copy, Cut, Paste and 
UNDelete. Click right on the Paste button to see the contents of the file !!CUT.TMP 
where Score4 keeps the copied information. 

4.2.10 Help button 
When an item is selected, the first help text page is shown momentarily while pointing to 
this button. For further explanation see the chapter ‘Advanced help output samples’. 

4.2.11 SH/Z button 
Usually the commands SH/Z and SHX/Z are given in succession. To speed this up there 
is a single button to perform these actions. The button remembers the last action, even 
when those commands are typed (in order. When not in order, ScoreEngine loses track 
and disables the button). 

4.2.12 Clear button 
The ‘Clear’ button resets all the text in the command screen except the top and bottom 
line. 

4.2.13 Position button 
This button positions the command panel. Point to the button to see the capabilities. 
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4.2.14 Minimize button 
Click with the left mouse button to minimize the command panel. With the right button 
both panels will be minimized. 

4.3 Command panel bottom line buttons 
In Score3, the bottom line functions are identical to the DOS version. You can use the 
Function keys or click on the text. Note that F10 is replaced by F11. 
In Score4, there are real Windows type buttons. F10 can be used. Occasionally, a button 
is disabled for a function as yet not implemented. Also, there are various differences 
between captions in the DOS version and ScoreEngine because of character set 
differences.  
Note that next to the button marked ‘6 Zm’ there is an empty space. Use other zoom 
features, ie. via ‘Screen>>’ or with a typed command. 
When in Edit mode, a colored text strip is shown on the music panel bottom with the text 
‘Click to where current item is to be moved/copied’. Click in the music to where the item 
is moved. Press the ‘Cut’ button to copy it and the text strip disappears. It will also 
disappear when clicked while the move/copy feature remains active. 
Example: 
 

 

4.4 Program status 
Under the command panel is an information part referred to as ‘Program status’. It has 
information about the current session. Point to the fields for supplementary information. 
The View menu (Less/More) controls the presence of this portion.  
When suppressed, the program may occasionally force it as a pat change is required. 
The bottom of the command Most useful are the ‘Arrow increment’ and DP settings 
which in DOS Score need to be inspected by a command to know their current values. 
The current filename does not show the path prefix but the current directory at program 
start is provided on the right. Point to the filename field to see the tooltip which has the 
current file’s path prefix (not given for SET files – the path prefix is in a separate field 
that comes up when selecting F2-INPUT in Score3). 
The creator field will have a pink background if different from the current Score 
installation (a file received from a Score system with a different license number). 
The white field can be clicked and has the same effect as a path change. Pushing the 
middle mouse button in this field is a quick way to see the folder’s contents. 
Each ‘G/GM/NX/NB’ command sets the highest staff number. The value is not updated 
by other manipulations such as adding a new top staff. Press ‘Refresh top staff’. When 
there are two values such as “3 (4)” this means that the highest staff is 3 but that there is 
an item for staff 4 for which there is no corresponding Code8 item. 

5 Score music display  
This panel corresponds to the DOS panel but can use the additional top and bottom lines 
for display. The bezel around the default display area disappears when working in full 
screen mode, as does DOS Score. The top is shown here:  



 32

 
 

The grey area receives a replication of the parameters on the command screen, compacted 
by omitting trailing zeros and zero parameters when in Edit mode. The CR and ESC 
buttons are identical to typing Enter or Escape. A fast way also to ESCape is by double 
clicking in the command area. Min does the Windows minimize. 
When the cursor moves over the More button – it is disabled in Edit mode – pop-up 
controls become visible. The slider on the left becomes visible when moving over the 
gray band. 
 

 

5.1 Pop-up controls  
The buttons with the captions Home, PgUp, PgDn, End, Page< and Page> correspond to 
keys. The Clear button erases the music display while the file remains in memory, and 
Redraw brings the music display back. Edited items are redrawn with a slightly lesser 
thickness. To normalize this, redraw the panel. 

5.2 Slider 
The slider defines the size (reduction percentage) of the music display panel. Some 
monitors do not give a good image at 100% and the proper setting for your screen may be 
better when smaller. Configurations with a single monitor may need to use a smaller 
music display as well to have the command screen and the music screen next to each 
other. Occasionally, the display becomes garbled and it is necessary to change the 
percentage one notch in either direction. 
The slider is normally invisible. Move the mouse to the area where the slider is hidden or 
to the gray band to make it visible. 
Here is an example from a Dell Inspiron 8600 with a 100% setting which would need a 
smaller display to get rid of the white spots: 

 
A slightly reduced panel size will give a better resolution: 
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On an Acer Aspire 2920, the 100% gives a good view, shown here with a different color 
scheme: 
 

 

5.3 Fit 
The tooltip of this button gives detailed explanation. It positions both the command panel 
and the music panel. This allows to easily setup the command form and the music display 
form in the preferred configuration. 

6 File functions 
ScoreEngine itself works in its program folder while user music files are in the user 
folder. The user cannot change the program folder. 
DRW, PSC, PFB and AFM files are in the folders defined by the Dispatcher. The path to 
PREF(-4).SCR must also be defines there. 
Note that some dynamic Score files are also in the program folder where Score4 resides: 
!!CUT.TMP,  !!CPR.TMP and #MUSDIR#.TMP in order to allow the use of the Score 
clipboard between DOS and Windows. 
Note that while running, ScoreEngine will create intermediate files in its program folder. 
None of the files in the program folder should be manipulated by the user as this will 
interfere with the proper functioning. 

6.1 Path definition 
The Program status has a white field giving the current path prefix used for all user files 
(music, EPS, PDF). This field can be changed by clicking on it. In Score3 you can also 
do the DRV command or the F6-DRIVE, F7-SET PATH functions. In Score4 you can 
also do the DR/DRV or PA command or ‘Path’ button. 
The CD – change directory – is equated to the DRV command. There is no need to 
change the path to the folder with DRW items as that is defined by the Dispatcher. 
This defined path is kept between sessions. Note that initially it is set to the program 
folder prefix. 

6.2 Drive and Folder selection 
All selections for drives and folders have a common Windows style user interface shown 
here: 
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The DOS notions of drive and path have thus been combined in ScoreEngine. 

6.3 MUSinfo 
This notion is a strong feature of ScoreEngine. When you have selected the option to 
include comments in EPS output, all original MUS file data is included and you have the 
possibility to restore a MUS file from such an EPS file. See the XEPS command and the 
Example of EPS comments. 

6.4 File selection 
There are various ways to select files: 

1. When ScoreEngine is started and the ‘keep selection’ option was set during an 
earlier execution, the indicated file opens immediately. Deselect the file by giving 
the Cancel option on the file selection panel. 

2. Via the File menu, the ‘Recent files’ collection can be consulted and selection 
made from there. 

3. With the ‘Open file’ button or the OP command which is equivalent to the G 
command without operand. In Score4 this corresponds to MkDir and Load. You 
get the Windows file selection panel. 

4. When the ‘drop file’ option is in effect, just drop a file from the Explorer or 
corresponding application to the white command panel. 

5. Commands such as GM, NX, NB etc., also open files. 
6. The DOS Score command of G with a filename is entirely supported though 

cumbersome compared to menu driven selection. 
 
Note that the File selection panel has a ‘Refresh’ menu. The Refresh option is provided to 
update the panel while a different process has changed the music file situation. Examples 
of this are: 

- the DOS version of Score created a new file while ScoreEngine is running. 
- a MUS file was erased with the Explorer or another application. 

 
In addition to the above ways to open a file, the following needs to be said: 
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1. Dropped file names can be text files (PMX) or EPS files with ‘MUSinfo’ since 

ScoreEngine can see the difference. 
2. Multiple MUS files can be opened in one go by selecting consecutive files from 

the Explorer and dropping them. A file named COMBINED.MUS will be made 
and loaded top to bottom. 

3. The Score4 ‘open more’ button (8 GtMor) is equivalent to the GM command. 
4. When holding the ALT key during a filename drop, this causes a GM function. 

6.5 Directories 
Windows style directories greatly improve the Score functions. There are two types: 
yellow background for summaries and white background for selections. The following 
commands show directories (see there for details): 
Summaries: 
 DIR [pattern] 
 DIRA [pattern] 
 DIRR [pattern] 
Selections: 
 G and GM without a name 

RES 
 TYPE 

XEPS 
 XIE 
 XIL 
 XILL 
Functions (Score3) 
 F1-LOAD 

F4-READ 
 Code11 ‘13 1’ 

Code15 ‘13 1’ 
Functions (Score4) 
 MkDir 
 Open, GtMor 
 NewNm (Code11) as well as ‘13 1’ 
 NewNm (Code15) as well as ‘13 1’ 
Special selection lists are given for DRW as well as for Code9 insertions (XIS) and 
changes.  

7 Text manipulation 
ScoreEngine has a few features on top of Score for handling Code16 items.  

7.1 Font name display and update 
When you select a text item, the name of the font is immediately shown on the bottom 
corner of the music display panel.  
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The command panel shows a few additional controls to either change just the font or the 
text portion. When the font prefix is overridden by Par8, this value will be given a pink 
background as to signal to the user that a prefix change would be ineffective. The font 
prefix becomes shaded and when you click this, a list rolls out with the fonts known to 
your Score. 
 

 
 

 
 

Click a selection and the font is modified. After making the change, Score will advance 
to the next item. 

7.2 Advanced text update 
There is also a ‘Modify text’ button which when left-clicked gives the text in an input 
box ready for change: 
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When right-clicked, the font prefix does not appear and text only is to be changed. A 
fast way to get the same effect is typing a period so you do not have to move the cursor 
from the music display to the ‘Modify text’ command button. 
The text highlighted in the example can be copied to the clipboard and used later in 
ScoreEngine or in any other Windows application, or vice versa. 
After update and OK the text is effectively changed. Cancel causes the item to be passed. 

7.3 Automatic syllable placement 
Placing syllables under a staff is always rather time consuming. An automated way saves 
you many keystrokes. 
Type your text in any Windows editor (Word, Notepad, Wordpad, etc.). Copy one or 
more sentences to the clipboard with Ctrl+C. Then, in ScoreEngine select the first note 
where the syllables are to be placed. All syllables in the selected text are assigned to 
notes from left to right. 
By default, it places syllables at -5. You can set the value in front of the syllables like so: 
 

 
 

 
 
Select the first note, and the presence of text on the Windows clipboard is distributed thus 
across the top staff. Generating syllables stops at the end of the staff. Then click on the 
first note of the bottom staff and generation continues. When there are no more notes or 
syllables, the generation stops. Remaining syllables remain on the clipboard when there 
are more syllables than notes. Whatever remains on the clipboard is visible by the user. 
The result of this syllable placement is shown here in PDF format: 

 
Text separators are a hyphen for a dash and two hyphens for an extender. They must have 
spaces on either side. The Score way for separators is also supported (/, !!, ??). To define 
a space within a syllable, use ‘$’. Accented characters are translated to the internal Score 
value. 
All syllables set Par9 to -360 conform the LJ program requirement. 
After placement, there is the possibility to undo this. 
The font and size of syllables is defined in the Dispatcher, tab ‘Compatibility’.  
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To position syllables to their notes (offset and center) use the XSYL command. 

7.4 Simple text input 
Score3: When you select F4-TEXT or type the TX command, the following panel rolls 
out: 

 
 
Make your adaptation (staff, horz., etc.) then follow the instructions. 
Score4: The TX command is not supported (although Score4 generates it by itself in 
which case the processing is correct). Use the Text button (Alt+F10) after ‘Items>>’ to 
choose the initial font, the list rolls out. 

7.5 Advanced text input 
To enter text, select any item. This defines the target staff number and the horizontal 
position. Then type the XIT (insert text) command and follow the dialog. A fast way is to 
select a staff item. Automatically a button appears with the caption ‘Enter text’. When 
pushing this button you will create a text item on this staff. A list of fonts rolls out from 
which you make a selection. Then the following panel appears with values and 
explanatory text. Text from the clipboard can be pasted in the blue fields. 
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Yellow fields cannot be changed. The blue fields can be typed into directly (or pasted 
from the clipboard). This example shows the font which was selected from the list. Fill in 
the desired fields and hit ‘Enter’ to create the text item. After pressing ‘Enter’ the dialog 
is removed, the text item is created, and the selected staff item is automatically 
reselected. The font/text portion is validated. When no text is typed, no text item is 
created. 
A strong feature is that a pasted text string is automatically converted to internal Score 
format such as ‘Jänner’ becoming ‘J%%anner’. 

8 Additional features, examples 

8.1 Parameter change by mouse 
In Edit Mode click on any parameter value to select it for change. Some parameters 
cannot be changed this way (1, 2, above 11 for text items, etc.). When a parameter is not 
displayed, type the place where it is supposed to be. By selecting it, the value gets a 
colored background and a menu rolls out under the parameter. Here is an example: 
 

 
 
Then select any action from the submenu and the value is changed accordingly. Round 
adapts the value to the nearest integer. 
Some parameter changes cause specific actions, such as Code1Par4 which can only be 
modified by integer steps, or Code16Par8 which rolls out a list of fonts from which a 
selection becomes the override. Notes allow rapid change of accidentals (Code1Par5) via 
again a special submenu, as well as their marks (Code1Par11). 

8.2 Slider editing (Score4) 
Right-click the rightmost bottom function button (usually it has ’10�’) when you are in 
Edit mode to open the slider editing feature. It is slightly different from DOS Score4 in 
that it has been reprogrammed entirely. Rather than sliding the mouse, there are now 
buttons to select and adapt parameters. 
This is a sample layout of slider editing after selecting parameter 9: 
 

 
 
The ‘step’ button replaces the ‘Normal/Fine’. You can select three levels of steps 
displayed in the yellow band. 
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A difference with DOS Score4 is that rounding is to the nearest integer. 
Changing parameters as described in the previous chapter is probably preferable. 

8.3 Advanced help output samples 
When this feature is set and an item is selected for editing, moving the mouse to the 
question mark button will instantly show the first page of the help file for that kind of 
item. It is demonstrated below. When the mouse is moved away from the button, the help 
text disappears. Moving the mouse pointer very fast may leave the help text. To remove it 
point to the area left of the ‘?-button’ or click the panel. 
An example of the first help form which appears when the help button is pointed to is 
shown here with the ‘4 fractions’ option set.  
 

 
 
When the HLP directory contains .HLP files not belonging to Score but are of the 
Windows variety, these will display normally when selected. 
 

 
 
The right mouse button pushed on the help button shows a page from the Score 
documentation with self-explanatory manipulation controls (subject to approval by 
Leland Smith). Note that this form can be resized. 
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8.4 Advanced reporting 
Some errors reported by Score but which do not make sense because they pass too 
quickly are intercepted by ScoreEngine. Here is an example: 
 

 

8.5 Fix of date format 
Since the year 2000, Score3 garbles the VER-command file date and time stamp, 
replacing some of the characters by asterisks. ScoreEngine fixes this and shows slashes 
rather than dashes to indicate the intervention: 
 

 

8.6 Example of full screen display 
When the entire size of the music display panel is used, a lot more of your page is visible. 
Full screen can show eight staves, while the reduced screen can only show six: 
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Note that when using the full screen in DOS, the bottom line instructions i.e. the F1-
HELP in Score3 and the function buttons in Score4 disappear, while in ScoreEngine they 
are shown in the command panel. It is therefore suggested to always work in Full screen 
mode. 
Score will revert to th reduced screen on an INP command. Use XFUL to reset full screen 
mode. 
In Score4 the music screen is slightly less tall (447 pixels rather than 480) because it does 
not use that bottom space correctly as a result from the original F-functions display. 

8.7 Example of EPS comments 
The header information of the EPS file enhanced by ScoreEngine is indicated here: 
 

%!PS-Adobe-2.0 EPSF-1.2 
%%Creator: SCORE (tm) Ver. 3.10 - enhanced by Score Engine v4.0.0.0 
%%Title: JAN001.MUS              
%%BoundingBox: 37 39 579 85 
%%DocumentFonts: (atend) 
%%Score path: JAN001.MUS - Date/time: 1/1/2011 4:20 :46 AM –  

Creator license: 3101073 –  
Program license: 3101073 –  
Measurement: INCHES 

%%EndComments 
 

Here is a staff generation: 
 

%% item 2 
%% parms 8  1  
0 -24000 m 
30000 -24000 l 
0 -23650 m 
30000 -23650 l 
0 -23300 m 
30000 -23300 l 
0 -22950 m 
30000 -22950 l 
0 -22600 m 
30000 -22600 l 
s 
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9 Inputting 
When you type the INP command (or in Score3 hit F2 to enter Input Mode or click on 
F2-INPUT; or in Score4 hit the F5 Input function button), the bottom line with the first 
few ‘staff setups’ is replaced by a menu showing all the xxx.SET files. Click on any 
name to select that file: 
 

 
 

After selecting a SET file, the panel can be closed by hitting a button. The combinations 
of function keys with ‘shift’ or ‘ctrl’ are not implemented. 
When you have typed the input in a text file (sample taken from the Score User’s Guide, 
page 14 which is provided as ScoreEngineSampleINP.TXT), you can copy/paste multiple 
lines in the input field (which will only show the first line) after hitting the ‘SPACE to 
Continue’ button: 
 

 
 
Make sure that there is a carriage return at the end of the copied text. If not, the dialog is 
displayed and the user needs to press ‘Enter’. 
 

 
 

and show this: 
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Syntax error handling is slightly different than in DOS as the error is highlighted: 
 

 
 
To replace the wrong ‘L’ here by ‘a’, just type ‘a’ and ‘Enter’. 

10 Command symbols 
There are two kinds of symbols that can be used in the command line. A symbol is a 
string of characters that represents a predefined value (String symbols) or action (System 
symbols).  

10.1 String symbols 
The user can define symbolic strings with the XEQU statement. There is one system 
symbol called $CURRENTFILE$ or $CF$ for short (upper case mandatory) which 
represents the file which is currently in memory.  
The command XRUN executes an external program. ScoreEngine makes a command 
string from the XRUN. When the external name has a path prefix, the run will be in that 
path. 
A string symbol can thus be used in any Score or ScoreEngine command. An example 
follows: 
 

g bach001 
xequ $accs$,'c:\score utilities\accs.exe' 
xrun $accs$,$CF$ 

 g $CF$ 

 
Symbols defined by XEQU are kept between sessions. They may be redefined and 
undefined. Use single or double quotes when the string contains spaces or quotes. To see 
which symbols are defined, use the File menu (Environment). 
In the above example, the first command establishes the current filename. The run works 
on the music file, not on the file in memory. The last line will bring the updated file in 
memory. 
It is generally not necessary to type long paths such as in the XEQU above as these can 
be copy/pasted into the keyboard field from the Explorer or another Windows 
application. 
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This feature partly overlaps the Score saved strings defined with apostrophe or colon 
which are expanded by ;, ;;, or ;;; but is not limited to number or size or to being entire 
command strings. 

10.2 System symbols 
These are primarily for the developer. The user can apply them in the XKEY command, 
ie. 
    XKEY [F1] 
is identical to pressing F1. 
The available symbols are: [F1] through [F10], [ALTF1] through [ALTF10], [DELETE], 
[END], [ESCAPE], [HOME], [PAGEDOWN], [PAGELEFT], [PAGERITE], and 
[PAGEUP], [ARROWDOWN], [ARROWLEFT], [ARROWRITE], and [ARROWUP] 

11 Commands 
A number of letter commands were added. Typically, the ones starting with an X are 
specific for ScoreEngine. ScoreEngine has added features to some commands or replaces 
them entirely. A help file named ‘ScoreEngine commands’ appears when pushing the 
button with ‘?’. An alphabetical list of the user extensions follows: 

11.1 DIR 
When the extended DIR option is set, the DIR command will use the full command panel 
to show the filenames and as such can give many more names in a single display. Close 
the display panel by clicking on any name. Note that Score ignores filenames longer than 
12 characters while ScoreEngine gives all names. The ‘?’ wildcard is allowed in DIR.  
 
The command ‘DIR [pattern].EPS’ provides an additional detail – whether the file can be 
used to recreate a MUS file from it. Sample output: 
 

 
 
The same format summary is given with selection capability (white background) for 
specific commands. 
The command ‘DIR [pattern].DRW’ shows the collection of ‘draw’ items. Here is a 
partial sample: 
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The same directory will be displayed in when you do an insert with the commands ‘XIL’ 
or ‘XILL’ or in Score4 when the ‘NewNm’ button is selected for a Code11 item. The 
backgrounds of selectable members is then white. 

11.2 DIRA 
Same as DIR but with details on file size and date/time stamp. 

11.3 DIRR 
Same as DIR but it presents the output as the DOS versions of Score. 

11.4 DP 
Additional to its Score function, the current status of this setting is always shown in the 
program status portion. 

11.5 DP- 
This makes all staves disappear. Identical to DP-1. The DP status field will have the text 
‘All staves’. 

11.6 DRV 
Drive change in ScoreEngine is not supported. Use the Path change to select another 
drive as path prefix. 

11.7 G 
This command can be given without a filename and thus will be identical to the ‘open-
file’ function. 
Additional information about the file is supplied on the bottom of the command form 
(full name, creator, size, date and time stamp, measurement). When the option is set, 
ScoreEngine forces a SH/Z command after the load. Note that Score is limited in its 
display vector and a file too big will not give the desired result. In that case, the DP-
command may be required. 
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11.8 GM 
This command can be given without a filename and thus will be identical to the ‘open-
file more’ function. 
On top of its normal function, the feature to automatically detect the highest staff may be 
performed. 

11.9 GM- and GM+ 
These commands GM’s the file which is alphabetically before or after the current one. 
The filename suffix must be identical. Note that you can only do this once as the base file 
name is not replaced. 

11.10  PMX 
The extended PMX gives accuracy of four fractional digits in tabular and more in 
condensed format. It does not prompt for a filename as it uses the current filename with 
the ‘.PMX’ suffix. 
When a file by that name exists already, the user is warned. 
Optionally comments may be generated. At the end of the file creation, the file is shown 
in full screen. 

11.11  PR 
This command is slightly different from the pure Score command. ScoreEngine does not 
send a print file to a printer. It always creates an EPS file. Also, the PR menu is replaced 
by a control file which is maintained by the EPS menu. When no control file is present, 
the user’s defaults are used except for parameters 1, 14, 15 and 16 which ScoreEngine 
overrides (1, 16) or ignores (14, 15). 
The reason to modify this command is primarily because of the optional post-processing 
capabilities of ScoreEngine and for user comfort. 
Pointing to the PR button shows the current EPS options setting, the name of the current 
font initialization file, and status of the EPS control file ‘ScoreEngineEPSsetup.txt’. 
Note that there are four ways to execute the PR command: 

♦ type PR 
♦ push the EPS button 
♦ push the function button or its equivalent bottom. 

Before you create a PDF, a PR must have been done. 
Instead of typing PR, press the ‘EPS’ button. With the right mouse button it will also 
make a PDF. 

11.12  RES 
This command can be given without a name. All Ascii text files in the current directory 
are given and a selection can be made. The first line of each file is given in the list. 
The command can have any text file name as operand. 

11.13  RS 
This also clears some fields in the Program status area. Use XRS to bypass the prompt 
when the file was not saved. 

11.14  SH, SHX 
When the option is set, the Z-command is automatically added. 
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11.15  TYPE 
This command replaces the Score command and Score4 function button entirely. Without 
an operand, a list of Ascii text files in the current folder is shown (with the first text line) 
from which a file can be selected. Display is full-screen. An filename may be given. 

11.16  XAB – abort update of file with long file na me 
Erase the file CURRENT.MUS in the work folder. This file is the copy of a selected file 
with a file path longer than 24 or 22 characters. The user may have applied changes to 
this file since its opening but these changes will be lost. The command also performs an 
RS command to assure it is no longer in memory. 

11.17  XCAF – change all fonts 
Change all fonts in Code16 texts. Overrides in Par8 are not affected. The syntax is:  

XCAF xx,yy 

where xx  is a font number of which each occurrence will be replaced by font number yy . 
Use the character ‘*” to change all fonts: XCAF *,00  changes all fonts in all Code16 
items to 00. 

11.18  XCC – copy current file with long file name 
This terminates the editing of the file CURRENT.MUS in the program folder. It is copied 
back to the original file with the long path. 

11.19  XDUM – delete dummy items 
Check if the current file has dummy items and optionally remove them. 
 

 

11.20  XE – EPS file display 
Display an EPS file with Notepad. When no filename is given, the name will be 
constructed from the current file. The suffix is assumed ‘.EPS’ suffix when missing. 

11.21  XENDING – first or second ending 
When an item in a bar is selected, this command will create a first or second ending 
Code05 item, with the left and right aligned to the adjacent barlines. Use a ‘2’ operand 
for the second ending. When no barlines are present, the staff ends are used. 
The selected item may be a staff item or a barline, in which case the ending will be 
generated from there. 
The first ending is one position shorter as to not coincide with the beginning of the 
second item. 
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11.22  XEPS – read enhanced EPS 
Read enhanced EPS file. The list of applicable files is given from which a selection can 
be made. An enhanced EPS file may be input with this command when it was made with 
comments by ScoreEngine and as such has MUSinfo. Note that you can also drop an 
enhanced EPS file from the Explorer in the command area, similar to PMX files and 
MUS file types. The result of XEPS is comparable to reading a PMX file. 
What actually happens in this process is that a temporary PMX file is made from the EPS 
file. 

11.23  XEQU – define equated string symbol 
See chapter ‘String symbols’. 

11.24  XFUL – set full screen 
The music display can be started with a reduced size or Score sets it in reduced size 
occasionally during operation (ie. by the INP command). Use this command to set full 
size. The preference as set by the Dispatcher is not affected. 

11.25  XFF – convert F-ligatures 
The character combinations ‘fi’ and ‘fl’ are changed to the Score ligatures ‘!i’ and ’!l’. To 
convert the other way around, enter the command ‘XFF 1’. 

11.26  XKEY – keyboard input 
Use this command to enter a command line which contains system symbols, ie. 
XKEY [F1] which is identical to pressing F1. 

11.27  XLJA – LJ all systems 
This command means ‘LJ all’. It analyzes the page for the system structure and LJ’s each 
system one by one. 

11.28  XNX, XNB – intelligent file advance 
Intelligent XN and XB as explained above – see Chapter ‘Commands’. 

11.29  XPDF – create PDF 
Immediately after a PR command, this command can be given to create a PDF file. It 
uses the EPS file just created by the PR command and the result has the same path prefix 
and name but with the PDF suffix. The resulting PDF is immediately shown. 
A requirement is that the path to the freely downloadable program PDFcreator has been 
established in the link profile. 

11.30  XRS – reset memory 
Same as RS but it automatically replies YES to the question to restart when this is given. 

11.31  XRUN – execute external program 
See chapter ‘String symbols’. 

11.32  XSD – screen dump 
Copy the command screen to file ScoreEngineScreenDump.TXT and show the file. This 
may be done to ask questions or report problems. 
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11.33  XSYL – align syllables 
Select a syllable. This tells ScoreEngine the current staff and the font/size by which it can 
recognize syllables in a file. Only text items with a negative vertical height (Par4) will be 
considered. The command will prompt to act on syllables on the current staff or the 
whole file, then center or align, then it asks for an offset. 
The offset value is moved to Par11 for the align function. For the centering function, the 
offset is a combination of the computed displacement plus the given offset value. 

11.34  Insert commands 
Several types of elements can be inserted with a command or via the Insert menu. Some 
commands require that you are in Edit Mode. The menu disables insertion commands 
when not in Edit Mode.  

11.34.1 XIK – insert character 
The following panel is shown: 
 

 
 

Select any character and the internal Score value will be generated where you are typing. 
This can be either in a command or in text input. 

11.34.2 XB – insert barré 
A note must have been selected. A barré item is generated from the current note to the 
highest note in the chord if there is one. Barré on a single note is possible as well. Note 
that the barré consists of three line items. 

11.34.3 XLGD – insert line going down 
When a note was selected, a small line going downwards in the direction of the note is 
generated left of the note. 

11.34.4 XLGU – insert line going up 
When a note was selected, a small line going upwards in the direction of the note is 
generated left of the note. 
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11.34.5 XIE – insert Code15 PostScript item 
An item must be selected. A list is shown of the EPS files which have a name shorter 
than 6 characters and qualify to be inserted as a Code15 item. It will be inserted above the 
selected item. 

11.34.6 XIL – insert library item (excluding LIBnn)  
An item must be selected. The table of Code11 library members is shown. Select a 
member from the list with the white background. It will be inserted above the selected 
item. 

11.34.7 XILL – insert library item (including LIBnn ) 
Same as XIL but DRW files starting with ‘LIB’ are also included in the list. 

11.34.8 XIS – insert symbol 
An item must be selected. A table with all Code9 symbols is shown and a member can be 
selected. It is inserted above the selected item. 

11.34.9 XIS3 – insert symbol from CODE9.DAT 
An item must be selected. A table with all Code9.DAT texts is shown and a member can 
be selected. It is inserted above the selected item. 

11.34.10 XIT – insert text 
An item must be selected. Optionally an integer operand may be given as a Par4 value 
which remains used until changed. Its initial value is -3. 

11.35  Fingering commands 
For guitar music, there are commands to place fingering according to house style. 

11.35.1 XFn – generate finger 
The XFn command can be given when a note was selected for editing. It will generate 
finger n (0 – 5) in front of the note, as customary in guitar music. The digit will receive 
the note’s horizontal position and the offset in Par15 depending on accidental, accidental 
offset and user settings. 

11.35.2 XSn – generate string 
To indicate a string as a circled number as is common in guitar notation, set n to 1-9 and 
it will be generated at the stem’s side. A stemmed note must have been selected. 

11.35.3 XPn – generate position 
A note must be selected. The Roman number equivalent of ‘n’ is generated above the 
note. This is valid for values 1 through 20. 

11.35.4 XC/ – generate a vertical line through C 
A text item starting with ‘C’ of size 1 must be selected. A vertical line is drawn through 
it. It is used by some engravers to indicate a barré position. 
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12 Score utilities 
For Page, Scorlas, Draw and Just, the same menu line and top buttons appear as with 
Score but most of them are disabled. The right side of the top buttons for the utilities has 
a different format: 

 
 
This gives a Cancel button to quickly terminate the program without any further 
processing. The three smaller buttons are to position the panel. 

12.1 PAGE(4) 

12.1.1 Long filenames 
PAGE under ScoreEngine handles Score music files with a long Windows style prefix. 
Non-music files like the namelist file or the Part Extraction Control File cannot have a 
long prefix but may reside in the current directory which by itself has a long prefix. 
When PAGE encounters long filenames in the namelist (which is made by the user with 
an editor, with a SIP selection, or by dropping), it creates the temporary namelist 
$$$$NAME.LST in the current directory. It also copies all the files from the namelist to 
the work folder and names these files $$$$0001.MUS and up. Then it proceeds to work 
from the temporary namelist. 

12.1.2 Other Page extensions 
Following the ‘Layout’ selection, Page asks ‘Will any single file contain more than 1 
system?’. This question is bypassed when you drop filenames. In that case, the input files 
are inspected for this situation and the question is replied automatically. 
Old Page Data is not supported. It was a useful feature in the time of slow computers but 
it no longer serves a purpose. 
In part extraction, ScoreEngine validates the contents of that file because DOS Page3 
does not do that very well. 
The output path by default is the same as the input files. 
Part extraction allows automatic creation of the control file. 
 
The control panel looks like this: 
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The filename drop feature is explained in the panel. Furthermore, the program runs as in 
a DOS environment. Note the three overlapping buttons on the top which help 
positioning the panel. 
 
The Page4 initial screen is shown here: 
 

 
 

A nifty feature was added to PAGE(4) which automatically makes the control file for 
parts extraction. Once option ‘2=Parts’ is selected, a text box appears: 
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Drop filenames from the Explorer to this yellow box and the file PARTS will be created. 
Also the subsequent ‘Enter’ is performed by ScoreEngine and the prompt to provide an 
instrument number will follow. 
The selected group of files is validated for proper sequencing. There cannot be holes in 
the numbering. Multifile pages are supported and must start with ‘A’ following the 
sequence number. Here is an example. The highlighted files were dropped on the yellow 
box: 

 
 
Then the message appears as: 
 

 
 
It shows you the occurrence of instruments as well. After pushing ‘OK’ the PAGE dialog 
continues as in DOS. 

12.2 SCORLAS(4) 
The control panel is identical to the DOS version: 
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When either 1 or -1 is selected, the program informs the user of the filename drop feature 
(when activated in the Dispatcher), allowing him to pass a selection from the Explorer 
and automation of subsequent prompts. Because SCORLAS under ScoreEngine can only 
output to files, the EPS filename is set automatically. When the Dispatch PDF option was 
set, a PDF of each EPS file is created immediately. 
 

 
 
The panel and functionality for SCORLAS4 are similar. 
Note that there are two enabled buttons on top in this example. These indicate that 
PCSEND and PDFcreator were selected. After the EPS files were made, output to 
PCSEND, respectively PDFcreator is done automatically. The buttons do not function – 
they just indicate the selection. 

12.3 DRAW(4) 
There is no need to select a different drive or path in ScoreEngine as reading and writing 
of DRAW files is always in the selected library. 
The initial panel looks like this: 
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By setting the ‘extended’ feature, there is no more need to type paths and filenames, thus 
greatly simplifying selection. 
The Path command will give a folder selection panel which is a familiar Windows 
selector (not shown here). 
The panel to get a member is shown here: 
 

 
 

Just click a name in the white list to open it for processing. ScoreEngine lets the selection 
follow by an “LI” command to show the vectors while displaying the member. An 
example of the display area is given here for LIBRA ‘bass’: 
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To read a vector list member, ScoreEngine goes through the current library and detects 
automatically those files which contain vector lists, then makes the summary like this: 
 

 
 
Just click a name from the white list and the file will open and perform the “LI” 
command. 
The buttons ‘RS’, ‘S’ (save) and ‘?’ are enabled during a Draw session. 
The DRAW4 description applies to this. 

12.4 JUST(4) 
Both JUST.EXE and JUST4.EXE are supported by ScoreEngine. Here is the opening 
panel for JUST4 (with the ‘drop filenames’ feature set): 
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When you select files from the Explorer and drop them to the white area, it assumes that 
you have structured your filenames with a numeric part per page and a letter as part of the 
page. The internal control table which is generated from the selection is shown and it 
detects by itself where the page separations are: 
 

 
 
The above selection, dropped to the command area, will cause this: 
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Then you type your command – a combination of J, L, and H. No more typing of input 
filenames is then required. You simply need to provide the output filenames when 
prompted. The question ‘Work on more data?’ is automatically replied as ScoreEngine 
advances to the next page. After the last page separator has been recognized, the program 
does the exit by itself.  
You can of course type input names as well by not setting the ‘drop’ feature but then you 
do not benefit from this advanced mechanism. 

13 Features currently under study 
Not necessarily in this order are the features and versions planned for future release: 

- defining a specific area with the mouse, Score Reference Manual p297; 
- undo/redo on any number of levels; 
- sound and Midi; 
- mouse wheel support; 
- advanced in-staff slur/tie positioning (thickest part in between staff lines); 
- allow a dynamic height of the taskbar; 
- intelligent ADn command taking care of multiple voices. 

Specific user requests will be honored if possible. 

14 Installation 
Download the demo program which is called installScoreEngine.msi from 
www.dekloe.be. To run production, acquire a license from the distributor. 
The installation puts the following files in the folder of your choice: 
 

BANNER.MUS   sample music file 
BANNER.TXT   sample lyrics file 

 COMDLG32.OCX   Microsoft module    
 MSCOMCTL.OCX   Microsoft module 

ScoreEngine.exe   the main program 
ScoreEngineBase.mod  collected service routines 
ScoreEngineDispatch.exe  the main program 
ScoreEngineDispatch.ico  the main program icon 

 SYSINFO.OCX   Microsoft module 
TABCTL32.OCX   Microsoft module 

 
Most systems will have the Microsoft modules already installed but others do not. 
The installer makes a shortcut of ScoreEngineDispatch.exe on the desktop to start 
ScoreEngine with a double mouse click. 
Only the Dispatcher can be executed by itself. 

14.1 Workfiles 
Once operational, the following workfiles are (or may be) created. They are readable with 
Notepad but should not be manipulated by the user: 
 

ScoreEngineBase.mod  distribution module with service files 
ScoreEngineClipboard.TXT  Score3 only – keeps cut/copied item 
 ScoreEngineConvert.TXT  conversion aid 
ScoreEngineDiagnostic.TXT  debugging aid 
ScoreEngineExecProfile.TXT keeps the user option between sessions 
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ScoreEngineEPSsetup.TXT  made when the EPS menu is performed 
ScoreEngineEPSlog.TXT  EPS creation history 
ScoreEngineFingeringOffsets.TXT created by ‘Sample offset values’. 
ScoreEngineFontInventory.TXT summary of fonts linked to ScoreEngine 
ScoreEngineLinkProfile.TXT  remembers the links to Score programs 
ScoreEnginePFB.TXT  font embedding workfile 
ScoreEngineRecentFiles.TXT recently created files by Score SA/SM 
ScoreEngineScreenDump.TXT debugging aid 
ScoreEngineStringSymbols.TXT updated by the XEQU command 
ScoreEngineTrace.TXT  debugging aid 

14.2 Service files 
While the Dispatcher or ScoreEngine itself are active, the folder where they were 
installed will have additional service files. These files are removed at the proper 
termination of the Dispatcher. 
 
 ScoreEngineEmulator.mod  the emulator 

ScoreEngine3nn.mod   runtime aid 
ScoreEngine4nn.mod   runtime aid 
ScoreEngine500.mod   runtime aid 
ScoreEngineBitmapnnn.bmp  runtime aid 
Score31p6nn.jpg   runtime aid 
SIPSTACK.EXE   module to combine several input files 

 SIPMONIT.EXE   module to obtain system info on monitors 
 SIPGETOS.EXE   module to check operating system version 

PCSEND.EXE    printer program (free third party tool) 
 ScoreEnginePFB.exe   program to embed fonts into EPS 
The modules starting with SIP are originally from the SIP suite of Score utilities.  

14.3 File placement 
These are the directories where files are placed: 
 
Program directory – where the ScoreEngine software is installed. Cannot be changed 
during operation. 
Score workfiles such as !!CUT.TMP, !!CPR.TMP and #MUSDIR#.DAT are placed in 
the program directory where Score4 resides. 
 
User file directory – Where by default the user keeps his music files. This folder also 
scontains files mad during runtime. The path can be changed at any time:  

SESTATS.TXT – Scorlas and Just workfile 
SCORE.SAV – a file made by Score 
Music files, EPS and PDF files  
SESTATS.TXT – statistics by ScoreEngine for Scorlas 
NAMES.SEP – namesfile made by ScoreEngine for several Score programs 
$$$$NAME.LST – namesfile made by ScoreEngine for Page 
BARS.TMP and DECnn.TMP – made by Page 

 
PSC, PFB and AFM directories  
The folders where these reside are to be defined once with the Dispatcher. 
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Score3 and Score4 
Depending on which Score(s) you have, these paths must be defined once by the 
Dispatcher: 
 
Score3 Program directory – where Score3 and its utilities are. 
Score3 LIB and HLP directory 
Score3 PREF directory 
Score4 program directory– where Score4 and its utilities are. 
Score4 LIB and HLP directory 
Score4 PREF-4 directory 
 
Work folder 
ScoreEngine requires a working folder in the root directory and should have a name 
shorter than ten characters. The Dispatcher requests you to define one. The default name 
is $EWORK. The folder is used for handling files with a long path prefix. 

14.4 Multiple installations of ScoreEngine 
It is entirely possible to install and run multiple occurrences of ScoreEngine provided 
they are installed multiple times in different directories. It is not necessary to duplicate 
the Score software. 

14.5 Installation issues 
The installation file comes as an ‘msi’. Virus scanners, e.g. Norton, can prohibit ‘msi’ 
files and need to be temporarily switched off. 
Use the Windows uninstall feature to remove ScoreEngine. Note that the directory where 
it was installed will still have some temporary .TXT files which you may want to remove 
by hand. The file ScoreEngine05.exe contains the license key and you may want to hold 
on to it for later use. 
The file ScoreEngineEmulator.mod is an object module that is considered suspect by 
some virus checkers and has been known to have been removed. ScoreEngine cannot 
work without this program so it must be declared ‘trusted’. 

15 Diagnostics 
The Dispatcher has a button ‘How to report a problem’. Follow the instructions. 
Even when ScoreEngine terminates involuntarily, it is always possible to have the last 
updates of the current MUS file saved. 

16 Calling ScoreEngine 
You can call the Dispatcher also from the command line or from another program and 
pass it an optional MUS filename. The calling format is: 
 

<drive>:\<foldername>\ScoreEngineDispatch.exe [<MUS  filename>] 

17 SIP and ScoreEngine 
SIP can call ScoreEngine, provided the two programs are linked. Linkage is prompted at 
initialization of SIP which maintains the path to the dispatcher in the profile 
SIPCNTR.INI. View this file by clicking the Beethoven picture. Another installation 
setting is the preference for either Score3 or Score4 emulation which is done in the global 
settings panel (push ‘Set project options’ on the ‘Other’ tab): 
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When both Score3 and Score4 are present, the user has the option to set his preference. 
Otherwise one of the options is disabled.  
There are two places where SIP calls ScoreEngine, thereby bypassing the Dispatcher.  
Since the Dispatcher is bypassed, any user settings in the Dispatcher must have been 
done beforehand. One place where the call is made is via SIP’s ScoreEngine menu which 
brings you to this panel: 
 

 
 

which is self-explanatory. A file need not be selected. When one is, then the ‘Run’ button 
will open that file in ScoreEngine. When a file is selected, it becomes ‘sticky’, i.e. it will 
be remembered for a subsequent execution of ScoreEngine. 
The second possibility is from SipInput, provided this licensed program is installed. The 
panel looks like this: 
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The checkmark for ScoreEngine is enabled when the link was established. Then, 
following running the utility, the created file is passed to ScoreEngine. 
Since SIP is linked to either Score3 or Score4, assure that it corresponds to the one 
ScoreEngine uses. 

18 Third party software 
The following products are or can be linked to or used in combination with ScoreEngine: 

♦ Score and its utilities, by Passport Designs, Inc. and Leland Smith; 
♦ Seps4id, by Thomas Weber; 
♦ PCSEND by Adobe Systems Inc.; (*) 
♦ PDFCreator, by PDFforge.com;  
♦ SIP and its utilities, by Jan de Kloe; 
♦ Font files (AFM, PFB) by various suppliers; 
♦ Any external tool via the XRUN command. 

ScoreEngine requires that when those products are used in conjunction, these may need 
to be separately licensed. 
(*) While a third party tool, it is delivered with ScoreEngine and will be in the 
installation folder during a ScoreEngine session. 
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19 Document update history 
 
Document 
Version 

Date Remark 

1.01 December 30, 2009 First publication 
2.00 October 4, 2011 Second major update for program release 4.0.0.0 
   
(end of text) 


